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Introduction 
This brief paper has been put together for users of The Master Genealogist; particularly 
those in the Canberra Users Group.  It does not set out to be encyclopaedic (the author’s 
chastening experience in digging slightly into the power of tags put paid to that), but it 
does set out to ease users into venturing into TMG’s tag facility. 

That said, tags are there to be used.  However, as Hoffman says: Don’t get tag happy! 

What are Tags? 
TMG stores data in tags.  An individual is simply a record number in TMG’s database – 
every of byte of information you enter is stored in one or more associated tags. 

Tags are different to flags 
Flags can be used in TMG to help sort and filter your records, but they are limited to single 
character values.  Some that come with TMG “out of the box” include: 

• Sex:   M, F, ? 

• Living:  N, Y, ? 

• Birth Order: ?, 1, 2, 3 … etc. 
 

Others can be added (and deleted) as needed.  For example, I have added the following 
flags to my TMG project: 

Corrected 
This was initially created with default value of N after I imported some very messy 
data into TMG, with the option of manually setting it to values of Y and P 
(partially).  Colours are associated with the tags, so I can see at a glance whether a 
record has been “tidied up”. 
I have since changed the default for new records to Y, since I hope the majority of 
new records will be already corrected. 

Shane_Ancestor and Tegan_Ancestor 
Both these flags have a value of Y or N, and are used to highlight lines of direct 
interest to my daughter and me within the larger database. 

The Flag Manager is found in the File menu. 

Types of Tags 
TMG ships with over 100 standard tags.  Use Reports > List of > Tags to obtain a list for 
your setup.  A copy of mine is at the Appendix of this paper. 

A quick look at that list will see that each tag has a name, an abbreviation, a tag group and 
a sentence. 

Why a group and why a sentence? 
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To take the last first: the sentence is used to produce narratives in reports such as: 
James Gregory (97) was born before 1840.  He lived on 23 Sep 1840 at 3?6 
Duke Street, Hume, Manchester, England.  He married Mary Runcorn (98), 
daughter of Richard Runcorn (874) and Elizabeth Faulkner (875), on 23 Sep 
1840 at Cathedral, Manchester, England.  He was Merchant on 23 Sep 1840 
at Hulme, Manchester, England.  He died on 9 Aug 1855. 

 

Sentences tell TMG how to present the data you have presented in something approaching 
English.  If you don’t plan to use these types of reports, then you may consider tags aren’t 
for you. 
The way tags are structured is also related to what group they are in.  This table is taken 
from Table 5-1 in Hoffman: 
 

Tag Group Contents of Tags in the Tag Group 

Name One principal, name of that person or name variation, date, 
memo and sentence 

Parent/child 
relationship 

Two principals related by blood, memo 

Birth 
Death 

One principal, date, place, memo and sentence 

Burial  
Marriage  
Divorce  
Address  
Other 

Two principals, date, place, memo and sentence 

History Witnesses only, date, place, memo and sentence 

 
 

Looking at standard tags 
Users can look at both the tags in their project, and the details of actual tags by going to 
Tools > Master Tag Type List > Edit (see Figure 1 – Tag Type Definition screen) 
 
This tag’s sentence reads: 

[P] <|and [PO]> arrived <[D]> <at [L]> 
 

An insight into this code is given by seeing this segment of a narrative report: 

He and Phoebe Barrett (155) arrived on 10 Apr 1842 at Australind, 
Western Australia, Australia. 
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Figure 1 – Tag Type Definition screen 

 
The breakdown of the code is as follows: 

[P] Principal of this event 
[PO] Other Principal of this event 

[D] Date of event 
[L] Location of this event 

 
It is clear that the letters in [square brackets] are “variables”, while code inclosed in 
<angle brackets> is conditional.  Had I not entered Phoebe in this event, the <|and [PO]> 
would have been ignored and the report sentence would have read: 

He arrived on 10 Apr 1842 at Australind, Western Australia, Australia. 
 

The vertical bar symbol | allows for sophisticated sentences.  For example, the following 
code: 

[P] <was|and [PO] were> associated <[D]> <[L]> 
allows for either of these sentence reports, depending on what data has been entered: 

He and Phoebe were associated on 10 Apr 1842 at Australind 
or 

He was associated on 10 Apr 1842 at Australind 
 
(though what meaning the second sentence would have is beyond me!). 
Appendix C from Hoffman provides a full list of the variables available to those wanting to 
create new tags or modify existing ones – and demonstrates what is in effect a rich 
programming language. 
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Creating Tags 
To create a new tag, one goes through the familiar path Tools > Master Tag Type List > 
Edit 
From there, you can Add a new tag, or Copy an existing one that is similar to the type 
you want to create – and then edit the copy to the form you require. 

An example 
To my mind, an obvious gap in the extensive set of tags which ship with TMG are two to 
cover non-marital relationships.   
Why bother?  Well, I believe any significant event in a person’s life should be recorded, 
and any event or relationship which results in a child needs recording.  Hence, I have my 
Defacto and Relationship tags. 

I use the Defacto tag for any marriage-like association which was not legalised by a 
wedding ceremony.  Children may or may not have resulted in these cases.  The 
Relationship tag is used where a less permanent, less marriage-like liaison results in a 
child. 

Let’s look at how these work.  The Defacto tag was created in the Marriage Tag Group, 
and is therefore treated more or less as a marriage by TMG.  Its sentence is straightforward 
and reads as follows: 

[P] began living in a defacto relationship <with [PO]> <[D]> <[L]> 
 
This produces a line like so within a narrative report: 

Annie Eliza Alexander (6) was born on 10 Jan 1869 at Marion, Smyth 
County, Virginia.  She began living in a defacto relationship with John 
Alexander (10) in 1885.   

 

Note that because PO, D and L are all conditional variables, the report would still have 
made sense if the name of the partner, or the date of their relationship was unknown.  As it 
is, location was not specified in the data set I used and was thus left out by TMG. 
Not surprisingly, the Relationship tag looks much the same: 

[P] entered into a relationship <with [PO]> <[D]> <[L]> 
as does the result: 

She entered into a relationship with John Keys Fugate (42) in 1890. 
 

Changing Individual Tag Sentences 
So far, we have looked at changes, or new tags which are global in effect; they effect all 
tags in the database.  However, it is possible to change the sentence of a single occurrence 
in a project. 
Opening a Tag Entry screen (see Figure 2 - Tag Entry Screen) will reveal a panel with a 
Sentence button in the lower left corner.  Clicking this will open a Sentence Structures 
panel. 
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Figure 2 - Tag Entry Screen 

 

Changing the sentence structure here will affect only this tag.   
 

Miscellaneous Points About Tags 
Firstly, TMG allows the user to customise Place Styles, be aware that reports are based, 
not on the name of a field, but its order. 
So, if you create for example, an Australian Place Style, where the 4th field (labelled 
“County” in the standard arrangement) is changed to “State”, and use the standard US 
Place Style as well, any report calling the 4th field will show either the county or the state. 

Secondly, I have avoided addressing the question of Roles in TMG because, at the time of 
writing, I am not confident I understand their use.  Some customised tags shown on TMG 
web sites rely on modifications to roles.  I leave the reader to explore these as you will. 

Concluding Comments 
If you are happy with TMG as it comes out of the box, or you expect never to use narrative 
reports, then modifying or creating tags may be of no interest to you. 
However, if you want to store those odd bits of information about your relatives in tags 
tailored to your particular needs, I suggest you experiment with customised tags in a “test” 
project (where you can’t wreck years of work while experimenting). 

While I agree that we should avoid being “tag happy”, I think there is value in trying some 
tags of your own! 

 
Shane Baker 
Canberra 
February 2004 
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Sources and References for Tags 
 
Hoffman, Lee H. (ed).  Getting the Most Out of The Master Genealogist.  

Modbury, SA: Gould Genealogy, 2003. 

 
Wholly Genes, The Master Genealogist version 5 Manual,  

Appendix D - Variables (Name Tags) 
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Appendix – Sample Tags Report 
  

List of All Tag Types 
 
 

 
Label Abbr Tag_group Sentence 
Address add. Address <As of [D],>[P] <and [PO]> lived at [L] 
Adoption ado. Other [P] <was|and [PO] were> adopted <[D]> <[L]> 
AFN afn. Other [PP] Ancestral File Number is [M] 
Age age. Other [P1] was [A] <as of [D]>. 
Anecdote ane. Other [M] 
Annulment ann. Other The marriage of [P] and [PO] was annulled <[D]> <[ 
Arrival arr. Other [P] <|and [PO]> arrived <[D]> <at [L]> 
Associatn ass. Other [P] <was|and [PO] were> associated <[D]> <[L]> 
Attributes  att. Other [P] <was|and [PO] were> [M] <[D]> <[L]> 
Baptism bap. Birth [P] was baptized <[D]> <[L]> 
BaptismLDS  bap. Other [P] <was|and [PO] were> baptized in the LDS church 
BarMitzvah  bar. Other [P] received [PP] bar mitzvah <[D]> <[L]> 
BasMitzvah  bas. Other [P] received [PP] bas mitzvah <[D]> <[L]> 
Birth b. Birth [P] was born <[D]> <[L]> 
Birth-Covt  bct. Birth [P] was born in the covenent <[D]> <[L]> 
BirthIlleg  b. Birth [P] was born illegitimate <[D]> <[L]> 
BirthStill  b. Birth [P] was stillborn <[D]> <[L]> 
Blessing bls. Other [P] <|and [PO]> received a blessing <[D]> <[L]> 
BlessngLDS  bls. Other [P] <was|and [PO] were> blessed in the LDS church  
Burial bur. Burial [P] was buried <[D]> <[L]> 
CancelSeal  can. Other The sealing for [P] <and [PO]> was cancelled <[D]> 
Caste cst. Other [P] <was|and [PO] were> belonged to the [M] caste  
Census cen. Other [P] <|and [PO]> appeared on the census <of [D]> <[ 
Christning  chr. Birth [P] was christened <[D]> <[L]> 
Codicil cod. Other [P] <|and [PO]> wrote a codicil <[D]> <[L]> 
Communion1  com. Other [P] <|and [PO]> received First Holy Communion <[D] 
Confirmatn  cnf. Other [P] <was|and [PO] were> confirmed <[D]> <[L]> 
ConfirmLDS  cnf. Other [P] <was|and [PO] were> confirmed by the LDS church 
Criminal crm. Other [P] <was|and [PO] were> [M] <[D]> <[L]> 
Death d. Death [P] died <[D]> <[L]> <[A]> 
Defacto def. Marriage [P] <was living in a defacto relationship|and [PO] 
Descriptn des. Other [P] <was|and [PO] were> described <as [M]> <[D]> < 
Divorce div. Divorce [P] and [PO] were divorced <[D]> <[L]> 
Divorce Fl  dvf. Divorce [P1] filed for divorce from [P2] <[D]> <[L]> 
Education edu. Other [P] <was|and [PO] were> educated <[D]> <[L]> 
Emigration  emi. Other [P] <|and [PO]> emigrated <[D]> <from [L]> 
Employment  emp. Other [P] <was|and [PO] were> employed <by [M]> <[D]> <[ 
Endowment end. Other [P] received [PP] endowment <[D]> <[L]> 
Engagement  eng. Marriage [P] <was|and [PO] were> engaged <[D]> <[L]> 
Event-Misc  msc. Other [P] <was|and [PO] were> [M] <[D]> <[L]> 
Excommuntn  exc. Other [P] <was|and [PO] were> excommunicated <[D]> <[L]> 
Father-Ado  Relationship  
Father-Bio  Relationship  
Father-Fst  Relationship  
Father-God  Relationship  
Father-Oth  Relationship  
Father-Ste  Relationship  
GEDCOM ged. Other Unrecognized GEDCOM data: [M] <[D]> <[L]> 
Graduation  grd. Other [P] <[PO]> graduated <in [M]> <[D]> <[L]> 
History his. History [W] witnessed [M] <[D]> <[L]> 
HTML htm: Other (see also [M]) 
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Label Abbr Tag_group Sentence 
Illness ill. Other [P] <was|and [PO] were> ill with [M] <[D]> <[L]> 
Immigratn imm. Other [P] <|and [PO]> immigrated <[D]> <to [L]> 
Living liv. Other [P] <was|and [PO] were> living <[D]> <[L]> 
Marr Bann mbn. Marriage Marriage banns for [P] <and [PO]> were published < 
Marr Cont mcn. Marriage A contract for the marriage of [P] and [PO] was si 
Marr Lic mlc. Marriage [P] and [PO] obtained a marriage license <[D]> <[L 
Marr Sett mst. Marriage A settlement for the marriage [P] and [PO] was mad 
Marriage m. Marriage [P] married [PO] <[PARO]> <[D]> <[L]> 
Milit-Beg mlb. Other [P] <|and [PO]> began military service <[D]> <[L]> 
Milit-End mle. Other [P] <|and [PO]> ended military service <[D]> <[L]> 
Misc msc. Other [P] <was|and [PO] were> [M] <[D]> <[L]> 
Mother-Ado  Relationship  
Mother-Bio  Relationship  
Mother-Fst  Relationship  
Mother-God  Relationship  
Mother-Oth  Relationship  
Mother-Ste  Relationship  
Name-Baptm  nam. Name [PP] baptism name was [N] <[M]> 
Name-Chg nam. Name <On [D]> [PP] name was legally changed to [N] <[M] 
Name-Marr nam. Name <As of [D],>[PP] married name was [N] <[M]> 
Name-Nick nam. Name <As of [D],> [P] also went by the name of [N] <[M] 
Name-Var nam. Name <As of [D],> [P] was also known as [N] <[M]> 
Namesake nsk. Other [P1] was named for [P2] 
Nationalty  nat. Other The nationality of [P] <and [PO]> was [M] 
Natlzation  nat. Other [P] <was|and [PO] were> naturalized <[D]> <[L]> 
Note nt. Other [P] <|and [PO]> [M] <[D]> <[L]> 
NullifyLDS  nul. Other [PP] ordinance was nullified by the LDS church <[D 
Num Child #c. Other [P] <|and [PO]> had [M] children. 
Num Marr #m. Other [P] <was|and [PO] were> married [M] times. 
Occupation  occ. Other [P] <was|and [PO] were> [M] <[D]> <[L]> 
OrdinacLDS  ord. Other [P] <|and [PO]> participated in an ordinance in the 
Ordinance ord. Other [P] <|and [PO]> participated in an ordinance <[D]> 
Ordination  ord. Other [P] <was|and [PO] were> ordained <[D]> <[L]> 
Parent-Ado  Relationship  
Parent-Bio  Relationship  
Parent-Fst  Relationship  
Parent-God  Relationship  
Parent-Oth  Relationship  
Parent-Ste  Relationship  
Probate pro. Burial [PP] estate was probated <[D]> <[L]> 
PrsmCancel  prs. Other [PP] ordinance was presumed cancelled <[D]> <[L]>  
Psgr List psg. Other [P] <was|and [PO] were> found on a passenger list  
Ratificatn  rat. Other [P] <was|and [PO] were> ratified <[D]> <[L]> 
Rebaptism rbp. Birth [P] was rebaptized <[D]> <[L]> 
Reference ref. Other Reference: [M] <[D]> <[L]> 
Relationsh  def. Marriage [P] <was|and [PO] were> in a relationship <[M]> <[ 
Religion rel. Other [P] <was|and [PO] were> [M] 
Reseal rsl. Other [P] <was|and [PO] were> resealed <[D]> <[L]> 
Residence res. Other [P] <|and [PO]> lived <[D]> <[L]> 
Restoratn rst. Other [P] <was|and [PO] were> restored <[D]> <[L]> 
Retirement  ret. Other [P] <was|and [PO] were> retired <[D]> <[L]> 
SealChild sc. Other [P] <was sealed as a child|and [PO] were sealed as 
SealParent  sp. Birth [P] was sealed as a parent to [PO] <[D]> <[L]> 
SealSpouse  ss. Marriage [P] was sealed as a spouse of [PO] <[D]> <[L]> 
Separated sep. Divorce 
SSN ssn. Other [PP] Social Security Number was [M] <[D]> <[L]> 
Stake stk. Address <As of [D],> [P] <and [PO] > <[L]> 
Telephone tel. Other [PP] telephone number was [M] <[D]> <[L]> 
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Label Abbr Tag_group Sentence 
VoidLiving  vdl. Other [PP] ordinance by proxy was cancelled <[D]> <[L]>  
WAC wac. Other [P] <was|and [PO] were> received [PP] initiatory o 
Will wi. Other [P] left a will <[D]> <[L]> 
 
 
Printed on: 18 Feb 2004                   
Prepared by: 
Mr Shane M Baker 
104 Bacchus Circuit 
Kambah   Australian Capital Territory   2902 
sbaker@pcug.org.au 
+61 2 6231 0965 
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Examples Contributed by Reg Johnson 
 

AWARD 
[P] <was|and [PO] were> awarded <[M1]> <[D]> <[L]> <[M2]> 
[W] witnessed the award ceremony of [P] <and [PO]> <[D]> <[L]> 
 

He was awarded The MBE (The Order of the British Empire - Member (Civil)) for services to cricket. 
 
Note: <[M2]> is there for additional data. 
 
 

BIRTHDAY 
[PF] <celebrated|and [PO] were> <[AE]> birthday <[M]> <[DD]> <[L]> 
[W] witnessed the birthday of [P] <and [PO]> <[D]> <[L]> 

 
Natalie celebrated at age 1 year birthday on 12 October 1974 at Noosa Heads, Queensland, Australia.1 
 
(I have a problem with the “at” here). 
 

Male 21st: 
[PF] <celebrated|and [PO] were> his 21st birthday party <[DD]> <[L]> <[M]> 
 

Matthew celebrated his 21st birthday party on Saturday 5 April 2003 at Southern Cross Club, 
Tuggeranong, ACT, Australia.2   

 
Female 21st: 
[PF] <celebrated|and [PO] were> her 21st birthday party <[DD]> <[L]> <[M]> 
 
Attendee: 
[W] was invited and  attended the 21st birthday party of [P]<[DD]> <[L]> <[M]> 
 

He was invited and  attended the 21st birthday party of Stephanie Johanna Gladwish on Saturday 11 
October 2003 at the Burns Club, Kambah 

 
Note: <[M]> is available for any additional data. 

 

                                                
1Personal knowledge of Reg W Johnson. 
2First hand Personal knowledge of Reg W Johnson of family. 
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CREMATED 
[PF] <was|and [PO] were> cremated <[M1]> <[D]> <[L]> <[M2]> 
[W] witnessed the cremation of [P] <and [PO]> <[D]> <[L]> 

 
He was Cremated on 18 March 1970 at Northern Suburbs Crematorium, Dehli Road, North Ryde, NSW, 02 
9887 2033,  
 
FUNERAL NOTICE 
JOHNSON - The relatives and friends of the late Kenneth Argyle JOHNSON of 125 Morrison Road 
Gladesville are invited to attend his funeral to leave Scots Kirk, Belmont Road Mosman tomorrow 
(Wednesday) 18th after a service commencing at 11.00am for the Northern Suburbs Crematorium. 
Bruce Maurer 
AFDA 
 
 

 

ELECTORAL ROLL 
[P] <was|and [PO] were> listed on the Electoral Roll <[D]>. <Also on the same roll 
was his wife, [R:wife].> <Prodigy of [PF] listed were [R:son],><[R:son1], 
><[R:son2],><[R:daughter],><[R:son3.]> The address being [L] <[M]> 

 
He was listed on the Electoral Roll in 1903. Also on the same roll was his wife, Margaret Marie 
Hanson. The address being Canrobert Street, Mosman, NSW, Australia.3   

 

ELECTORAL ROLL1 
[P] <was|and [PO] were>again listed on the Electoral Roll <[D]>. <Also on the same 
roll was his wife, [R:wife].> <Prodigy of [PF] listed were [R:son],><[R:son1], 
><[R:son2],><[R:daughter],><[R:son3.]> The address now being [L] <[M]> 
 

He was again listed on the Electoral Roll in 1908. Also on the same roll was his wife, Margaret Marie 
JOHNSON. The address now being Myahgah Road, Mosman, NSW, Australia. 

 
ELECTORAL ROLL2 

[P] <was|and [PO] were> listed a third time on the Electoral Roll <[D]>. <Also on the 
same roll was his wife, [R:wife].> <Prodigy of [PF] listed were [R:son],><[R:son1], 
><[R:son2],><[R:daughter],><[R:son3.]> The address being [L] <[M]> 

 
He was listed a third time on the Electoral Roll between 1913 and 1920. Also on the same roll was his 
wife, Margaret Marie JOHNSON. Prodigy of George listed were Clarence Ritchie Errol JOHNSON, 
Keith Ormond Edley JOHNSON, The address being 60 Awaba Street, Mosman, NSW, Australia.   

 
 

                                                
3Per Electoral Roll. 
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Military sentences contributed by Elizabeth Estbergs 
Name Sentence No. in 

examples 
below 

Milit-Beg [P] <|and [PO]> began military service <[D]> <[L]> 
<[M]> 

1 

Milit-End [P] <|and [PO]> ended military service <[D]> <[L]> 2 
Milit-Parade [PF] <|and [POF]> took part in the Anzac Day Parade 

<[D]> <[L]> <[M]> 
3 

Milit-
Regiment 

[RS:Principal] Regiment was <[M]>. 4 

Milit-Service 
no. 

[RS:Principal] military service number was <[M]>. 5 

Mlt award [PF] received a military award <[D]> <[L]> 6 
Mlt discharge [P] was discharged <[D]> <[L]> 7 
Mlt injury [P] received a war injury <[D]> <[L]> 8 
Mlt pension [P] received a military pension <[D]> <[L]> 9 
Mlt posting [RP:Principal] was posted <[D]> <[L]> 10 
Mlt posting 
end 

[PFS] military posting ended <[D]> <[L]> <[M]> 11 

Mlt posting1 [RS:Principal] next posting was<[D]> <[L]> 12 
Mlt promotion [P] was promoted <[D]> <[L]> to [M]. 13 
Mlt transfer [PF] was  transferred <[D]> <[L]> 14 
 

Samples 

Individual Narrative of Jack Vernon Zachariah 
 

Jack Vernon Zachariah  was born on 2 Sep 1909 in Gisborne, New Zealand.   
(1) He began military service on 29 May 1940 in Sydney, NSW, Australia. (5) His military 
service number was NX22367. (11) Jack's  military posting ended on 25 Jun 1941 in New 
South Wales. 12) His next posting was on 28 Jun 1941 in Middle East.  (11) Jack's  
military posting ended on 20 Mar 1943 in Middle East. (12)  His next posting was on 28 
Mar 1943 in Darwin, NT, Australia (11)  Jack's  military posting ended on 23 Jun 1943 in 
Darwin, NT, Australia. (12) His next posting was on 25 Jun 1943 in Queensland.   
He married Olga Landau in Melbourne, Vic., Australia, in 1943.   

(13)He was promoted before 1944 to corporal.  (11)Jack's  military posting ended on 24 
Aug 1944 in Queensland.  (10)He was posted on 21 Sep 1944 in Vic., Australia.  He was 
ill with Suspected lymphosarcoma diagnosed by microscopic section on 16 Nov 1944.  
(2)He ended military service on 13 Nov 1945; With the rank of Corporal.  (4)His Regiment 
was 2/1 Australian L.A.A. Regiment in the Australian Army. (9) He received a military 
pension on 11 Feb 1961 in Melbourne, Vic., Australia.   

He died on 5 Oct 1963 in 17 Roselea St, South Caulfield, Vic., Australia, at age 54.  He 
was buried on 15 Oct 1963 in Springvale Necropolis, Springvale, Vic., Australia. 
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Individual Narrative of Charles Landau 
Charles Landau  was also known as Charles Neven  or Charles Nevin .  He was born in 
1885 in Broadway, U.S.A.  On his Medical History sheet on 29 August 1903 he said he 
was 18 years and 6 months, making him born in February 1885. He also said he was born 
in Melbourne, Australia.  
Charles , Nathan and Dora their mother, immigrated, on 19 Jan 1889 to Melbourne on the 
Hohenzollern. Dora wrote the ship's name as Noen Jollie on her naturalization papers, but 
no ship of that name came to Victoria in 1889.  Simon, their father, on his admission to the 
Ballarat Benevolent Asylum in 1904, said he arrived in 1884 and lived in Melbourne.  
(1)He began military service on 27 Aug 1903 in Cardiff, Wales. (4) His Regiment was 
Loyal North Lancashire Regiment Number 2 Battalion.  He was height 5 feet 5 1/2 inches; 
weight 132 pounds; Chest measurement  minimum 34 1/2 inches; Chest measurement 
maximum 36 1/2 inches; Physical description good; 1 vaccination mark on left arm. He 
was described as 132 pounds, 5 feet, 5 inches, Brown hair, Brown eyes, Fresh skin, age 18 
on 29 August 1903.  He was of  British nationality. (5) His military service number was 
7633.   

On Charles' Military History Sheet as name and address of next of kin he lists his father as 
Samuel Neven of 11 Dana St Ballarat Victoria and in different writing the address is 
crossed out and Mother Dora 16 Chauvel St Ballarat East, Victoria, Australia added. 
(10)He was posted on 20 Feb 1904; Gibralter, 50 days. (12) His next posting was on 11 
Apr 1904; South Africa, 2 years 21 days.   
He was ill with malaria.  According to the Medical Board Report suffered no disability in 
Mauritius. (10) He was posted on 8 Jan 1907; South Africa, 284 days.  
(6) Charles  received a military award in 1908; India General Service Medal.  

(10) He was posted on 21 Jan 1908; Mauritius, 2 years 41 days.  
(12) His next posting was on 29 Nov 1909; East India, 5 years 79 days.   

He married Clara Foster on 25 May 1913 in India; Rites of the Jewish Religion. Placed on 
the marriage roll 1 April 1914.   

(4)His Regiment was 2nd Battalion Loyal North Lancashire Brigade.   
(12) His next posting was on 16 Feb 1915; East Africa, 2 years 326 days.  

(13) He was promoted in 1915 to Lance Corporal. 
(6) Charles  received a military award in 1915; Loyal North Lancs Regiment. British 1915 
Star.  (12) His next posting was on 8 Jan 1918; India, 3 years 298 days. (5) His military 
service number was 3591191.  
(7) He was discharged on 8 Oct 1921; Infantry. Medical discharge.   

(14)Charles was  transferred on 3 Nov 1921; 1st Battalion Border Regiment. Acting 
Sergeant Landau age 35 in 1921 service 27-8-03 to 2-2-04 at home, 9-2-04 - 30-1-09 South 
Africa 30-1-09-3-2-15 India 3-2-15-7-1-18 East Africa 7-1-18-20-9-19 NWF.   
(6) Charles  received a military award in 1924; India General Service Medal 1908 with 
clasp Afghanistan North West Frontier 1919 issued 10 Jan 1924.  
(13) He was promoted in 1930 to Quartermaster Sergeant.   

(3)Charles  took part in the Anzac Day Parade on 26 Apr 1939 in Melbourne, Vic., 
Australia, He wore 8 medals including the Meritorious Service Medal (Baluchistan), 
Victory Medal, British War Medal.   
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He was found on a passenger list on 9 Feb 1940; Strathmore, departing from Melbourne, 
Vic. The P&O steamship was under the captaincy of E.P. Lyndon bound for London via 
Colombo and Bombay. Charles Landau was listed as a wireless operator aged 52, British 
nationality of Australia and country of future permanent residence was India. Clara was 
aged 52 and listed as home duties, otherwise all other description was the same. There 
were only 23 passengers. 
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